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Safety information

¢ Connect the power cord to a properly grounded electrical outlet that is near the product and easily accessible.

CAUTION: Do not use the fax feature during a lightning storm. Do not set up this product or make any electrical or cabling connections, such as the power
cord or telephone, during a lightning storm.

e Use only a 26 AWG or larger telecommunications (RJ—11) cord when connecting this product to the public switched telephone network.

* Refer service or repairs, other than those described in the operating instructions, to a professional service person.

e This product is designed, tested, and approved to meet strict global safety standards with the use of specific Lexmark components. The safety

features of some parts may not always be obvious. Lexmark is not responsible for the use of other replacement parts.

CAUTION: Make sure that all external connections (such as Ethernet and telephone system connections) are properly installed in their marked plug—in
ports.

* Your product uses a laser.
CAUTION: Use of controls or adjustments or performance of procedures other than those specified herein may result in hazardous radiation exposure.
* Your product uses a printing process that heats the print media, and the heat may cause the media to release emissions. You must understand the
section in your operating instructions that discusses the guidelines for selecting print media to avoid the possibility of harmful emissions.

This symbol indicates the presence of a hot surface or component.
CAUTION: To reduce the risk of injury from a hot component, allow the surface to cool before
touching.

Conventions

Note: A note identifies something that could help you.
CAUTION: A caution identifies something that could cause you harm.
Warning: A warning identifies something that could damage your product hardware or software.
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o Finding information about the MFP
\/—

The Lexmark™ X340/X340n/X342n Multifunction Printer (MFP) comes with the following resources:

Setup sheet

Description Where to find

The Setup sheet gives you instructions for setting | You can find this document in the MFP box or on the
up hardware and software. Lexmark Web site.

User’s Guide

Description Where to find

The User’s Guide gives you instructions for using | You can find this document on the Lexmark Web site or
the MFP and other information such as: on the software CD that came with the MFP.

¢ Maintenance
* Troubleshooting

e Safety
CD
Description Where to find
The CD contains drivers, software, and You can find this CD in the MFP box. See the Setup
publications files. sheet for installation instructions.

Finding information about the MFP
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Readme file

Description Where to find

This file contains late-breaking information about | To access the Readme file:

the MFP and software that does not appear in 1 Click Start > Programs or All Programs ->
other documentation, as well as information Lexmark -> Lexmark X34x Series

specific to your operating system.
g 2 Select Readme.

Web site
Our Web site contains a variety of information. Visit our Web site at www.lexmark.com.
Note: All paths for the Web site are subject to 1 Go to the Web site.
change. 2 Select a country or region from the drop-down list in
the upper-left corner of the page.
3 Select the link for the information you need.

Record the following information (located on the store receipt and the back of the MFP), and have it
ready when you contact us so that we may serve you faster:

Machine Type number:
Serial number:
Date purchased:

Store where purchased:

Finding information about the MFP
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e Setting up the MFP
\/—

Before unpacking your MFP, select a level, stable surface on which to set it. Allow adequate space for
air circulation and opening covers and trays.

Clearance space

Front | 400 mm (16 in.)
Back | 175 mm (8in.)
Right | 127 mm (3 in.)
Left |50 mm (2in.)
Top 175 mm (7 in.)

Setting up the MFP
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Installing an overlay for another language

These instructions apply only if you received one or more additional language overlays with the MFP.

1 Lift and remove the overlay.

[

2 Choose the correct overlay for your language.

3 Align the overlay with the buttons on the MFP, and then press down until the overlay locks into
place.

Installing an overlay for another language
10



Installing an additional paper tray

Your MFP supports one optional paper tray that lets you load up to 550 sheets of paper.

CAUTION: If you are installing a 550-sheet paper tray after setting up the MFP, turn the MFP
off, and unplug the power cord from the wall outlet before continuing.

Unpack the 550-sheet paper tray, and remove any packing material.
Place the paper tray in the location you have chosen for your MFP.

Align the holes in the MFP with the positioning posts on the 550—sheet paper tray, and lower
the MFP into place.

4 Click Start > Settings > Printers or Printers and Faxes.
or

Click Start > Control Panel > Printers and Other Hardware > Printers and Faxes.

5 Select the MFP icon.

6 Click File > Properties.

7 Click the Device Settings tab.

8 Select Tray2 from the Installable Options list.

9 Select 550-Sheet Tray from the drop-down menu.
10 Click Apply.
11 Click OK.

Installing an additional paper tray
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12 Connect the power cord to a wall outlet.

13 Press the Power switch.

Getting the MFP ready to print and scan

Installing the software for USB attach

You can install printer drivers and scan software for the following operating systems using the
Software and Documentation CD:

e Windows 2003

e  Windows 2003 x64
e Windows XP

e Windows XP x64

e  Windows 2000

Note: Drivers for Windows XP x64 bit Edition are available at www.lexmark.com.

Insert the Software and Documentation CD.
Follow the instructions on the screen.

Connect the USB cable, and turn on the printer.

The Plug and Play screen appears, and a printer object is created in the printers folder of the
computer.

If the software installation screen does not appear:

1 From the desktop, double-click My Computer.
For Windows XP, click Start to access the My Computer icon.

2 Double-click the CD-ROM drive icon. If necessary, double-click setup.exe.

Getting the MFP ready to print and scan
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3 When the software installation screen appears, click Install or Install Now.

4 Follow the instructions on the computer screen to complete the installation.

Installing the software for network attach (X342n only)

You can install printer drivers and scan software for the following operating systems using the
Software and Documentation CD:

e Windows 2003

e Windows 2003 x64
e Windows XP

e Windows XP x64

e Windows 2000

Note: Drivers for Windows XP x64 bit Edition are available at www.lexmark.com.

1 Connect the ethernet cable, and turn on the printer.

Insert the Software and Documentation CD.
Follow the instructions on the screen.

The Plug and Play screen appears, and a printer object is created in the printers folder of the
computer.

Note: The ethernet connection will not work if the USB connection is being used. Only
one connection port can be used at a time.

If the software installation screen does not appear:

1 From the desktop, double-click My Computer.
For Windows XP, click Start to access the My Computer icon.

2 Double-click the CD-ROM drive icon. If necessary, double-click setup.exe.

Getting the MFP ready to print and scan
13


http://www.lexmark.com

3 When the software installation screen appears, click Install or Install Now.

Follow the instructions on the computer screen to complete the installation.

Getting the MFP ready to fax

You can connect the printer to equipment such as a telephone, an answering machine, or a computer
modem. If problems occur, see Setup troubleshooting on page 72.

Note: The printer is an analog device that works best when directly connected to the wall
jack. Other devices (such as a telephone or answering machine) can be
successfully attached to pass through the printer, as described in the setup steps.
If you want a digital connection such as ISDN, DSL, or ADSL, a third-party device
(such as a DSL filter) is required.

You do not need to attach the printer to a computer, but you do need to connect it to a telephone line
to send and receive faxes.

You can connect the printer to other equipment. See the following table to determine the best way to
set up the printer.

Connecting directly to a telephone wall jack

CAUTION: Use only a 26 AWG or larger telecommunications (RJ-11) cord when connecting
this product to the public switched telephone network.

Connect the MFP directly to a telephone wall jack to make copies or send and receive faxes without
using a computer.

1 Make sure you have a telephone cord and a telephone wall jack.

2 Connect one end of the telephone cord into the LINE port |¢] of the MFP.

Getting the MFP ready to fax
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3 Connect the other en of the telephone cord into an active telephone wall jack.

Note: For more information on connecting the MFP to telecommunications equipment,
see the additional setup instructions that came with the MFP. Setup steps may vary
depending on your country or region.

Connecting to a telephone

Connect a telephone to the MFP to use the fax line as a normal telephone line. Then set up the
printer wherever your telephone is located to make copies or send and receive faxes without using a

computer.

1 Make sure you have the following:

e Atelephone
¢ Two telephone cords
* Atelephone wall jack
2 Connect one telephone cord to the LINE port [¢] of the MFP, and then plug it into an active
telephone wall jack.

Getting the MFP ready to fax
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3 Remove the protective plug from the EXT port of the MFP.

>

4 Connect the other telephone cord to a telephone, and then plug it into the EXT port of the
MFP.

Note: For more information on connecting the MFP to telecommunications equipment,
see the additional setup instructions that came with the MFP. Setup steps may vary
depending on your country or region.

Getting the MFP ready to copy

The X340/X340n/X342n can be used as a stand-alone copier and does not require additional setup
or connection to a computer or a network.

Getting the MFP ready to copy
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a Learning about the MFP

Understanding the parts of the MFP

9
8
Use the To
1 ADF paper support Extend to support longer media.
Paper guides Make sure paper feeds correctly.
3 Automatic Document Copy, scan, or fax multiple—page documents.
Feeder (ADF)
4 Top cover Access the scanner glass.
Control panel Operate the MFP. For more information, see Using the control
panel buttons on page 20.
6 Output paper support Hold longer paper in the front output tray.
Learning about the MFP
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Use the

To

7 Front output tray Hold paper as it exits the MFP.

8 Front cover Access the toner cartridge.

9 Paper tray Load paper automatically.

10 Manual feeder Load paper manually.

11 Paper level indicator Verify the level of paper in the paper tray.
12 Access button Release the front cover.

13 Scanner glass Scan, copy, or fax a single—page document.
14 Scanner lock Lock the scanner unit during transport.

Understanding the parts of the MFP
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Use the To

15 Rear hinges Lift the top cover to fit thicker documents, such as books.

16 Power switch Turn the MFP on or off.

17 Power supply port Connect the MFP to a power source.

18 Dust cover Protect longer sizes of paper that may extend beyond the edge of
the MFP.

19 Rear cover Remove heavier paper from the printer as it exits.

20 Ethernet port Connect the MFP to a network using an ethernet cable.
Note: This port is only available on the X342n. The ethernet port
and the USB port cannot be used at the same time.

21 USB port Connect the MFP to a computer using a USB cable.

22 LINE port Connect the MFP to an active telephone line to send and receive
faxes.

23 EXT port Connect the MFP to a telephone or answering machine.

24 Handles Lift the MFP.

Understanding the parts of the MFP
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Using the control panel buttons

The display shows:
MFP status
Messages
Menus
LY
Ry
//;
12 11 10 98
Press To
1 Copy Access the Copy mode to make copies.
Note: The mode is selected when the button light is on.
2 Fax Access the Fax mode to fax.
Note: The mode is selected when the button light is on.
3 Scan Access the Scan mode to scan.
Note: The mode is selected when the button light is on.
4 Scale Control the size of a copied document as compared to its original size.
5 Collate Control the sequence in which multiple-page jobs are completed.
Options (Copy) * Adjust the paper source.
¢ Adjust the paper saver settings.
Speed Dial buttons Access any of the first five programmed shortcuts.
Shift Access shortcuts 6-10.
Note: Press Shift, and then press the first speed dial button to dial shortcut
6. Press Shift, and then press the second speed dial button to dial shortcut
7, and so on.
9 Options (Fax) ¢ Access the Broadcast function.
* Delay sending a fax.
¢ Cancel a fax.
10 - (On/Off Hook) Manually send or receive a fax.

Using the control panel buttons
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Press To
11 Redial/Pause ¢ In Fax mode, redial the last number entered.
* Insert a three—second pause in the number to be dialed to wait for an
outside line or get through an automated answering system. Enter a
pause only when you have already begun programming the number.
12 Phone Book Access any of the programmed shortcuts. For more information on
programming a shortcut, see Setting up shortcuts on page 47.
15 /1 6 17\ 1 f
(CRONC) 8 \
ooo| 2© OF
ooo|l ¢
000 //
N\
22 21 20 19
Use this To
13 v e Scroll through menu options.
¢ Decrease a number.
14 A ¢ Scroll through menu options.
* Increase a number.
15 \/ ¢ Choose the option that appears on the display.
* Save settings.
16 Numeric keypad In Copy mode: Select the number of copies you want to make.
In Fax mode:
e Enter fax numbers.
* Select letters when creating a Phone Book entry.
* Type numbers to enter or edit the time or date on the display.
17 Content Select the type of material being copied or faxed. Select one of
the following choices:
e Text
¢ Mixed—text and photo
e Photo
18 Start Start a copy, scan, or fax job, depending on which mode is

selected.

Using the control panel buttons
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Use this To

19 Stop ¢ Return settings to their default values, depending on which
mode is selected.

¢ Cancel a copy, scan, or fax job.
e Exit a menu.

20 Darkness Select one of five darkness settings.
21 Menu Display a control panel menu or submenu.
22 Back Return to the previous menu without saving any changes.

Note: Press \/ before pressing Back to save your settings.

Using the control panel menus

Navigating the control panel menus

Press Menu.
Press A or W repeatedly until the menu you want appears, and then press V.
Press A or W repeatedly until the menu option you want appears, and then press V.

Press A or W repeatedly until the setting you want appears.

o A WO N =

Press V to save the setting.

Printing a list of menu items

1 From the control panel, press Menu.
Press A or V¥ repeatedly until REPORTS appears, and then press V.
Press A or W repeatedly until Print Menus appears, and then press V.

The MFP prints a list of all available menus and default settings.

Printing a network setup page (X342n only)
You can print a network setup page to review the network settings.
Note: This menu item is only available when the USB cable is unplugged.

1 From the control panel, press Menu.
2 Press A or V¥ repeatedly until REPORTS appears, and then press V.

3 Press A or V¥ repeatedly until Network Setup appears, and then press V.

Using the control panel menus
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4 The MFP prints the network setup page.

Copy Defaults menu

Use this To

Darkness Improve the readability of a copy by darkening a light document or lightening a
dark document.

Content Specify the type of document being copied: Text, Mixed, or Photo.

Number Specify how many copies to print.

Scale Specify the percentage for enlarging or reducing an image copy.

Collate Collate copies as they exit.

Paper Source

Select the paper source you want to use.

Paper Saver

Choose how many page images to print on a page.

Fax Advanced menu

Use this

Auto Answer

To

Modify answer settings.

Behind PABX

Indicate if there is a telephone switching device.

Dial Method

Select where the dialing method should be pulse or tone for a fax job.

Fax Forwarding

Forward a fax to another fax machine.

Fax Footer

Add a footer to a fax.

Auto Reduce

Automatically reduce the size of a document for faxing.

Confirmation

Print a confirmation page each time a fax is sent or if there is an error while
faxing.

Using the control panel menus
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Fax Defaults menu

Use this To

Content Choose the quality of the image being sent.
Note: Changing the content may also increase the time necessary to send the
fax.

Original Size Specify the default size of original documents to be faxed.

Darkness Improve the readability of a fax by darkening a light document or lightening a
dark document.

Rings Specify the number of rings before the MFP automatically answers an
incoming fax.

Distinct Ring Choose the type of ring that indicates an incoming fax, if the fax number has a
distinct ring.

Redials Choose the number of redial attempts after a failed fax transmission.

Redial Wait Choose the number of minutes to wait before an automatic redial.

Paper Source Select the paper source you want to use.

Speaker Turn the speaker on or off to monitor the fax tone.

Volume Specify the volume of the telephone ring for incoming faxes or specify the
volume of the speaker to monitor the fax tone.

Prefix Set an extension to dial before dialing any autodial number. For example,
enter a prefix if you must dial an extension to reach an outside line.

ECM Ensure accurate, error—free transmission with another ECM-equipped fax
machine.

Station ID Set the fax machine number or ID name that appears on the fax header.

Changing the default mode
The MFP settings default to copy mode. To select another mode as default:

Press Menu.
Press A or ¥ repeatedly until MACHINE SETUP appears, and then press V.
Press A or ¥ repeatedly until Mode appears, and then press V.

Press A or ¥ repeatedly until the mode you want appears.

g A WO N =

Press y/ to save the setting.

Setting the Timeout option

If you change the copy or fax settings using the control panel buttons for a specific job, the MFP will
restore the default settings after a set period of time.

Using the control panel menus
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To set the length of time the MFP waits before restoring default settings:

Press Menu.

Press A or ¥ repeatedly until MACHINE SETUP appears, and then press V.
Press A or ¥ repeatedly until Timeout appears, and then press ‘/

Press A or ¥ repeatedly until the length of time you want appears, and then press V.

a A WO N =

Press Back repeatedly to return to the Ready prompt.

Setting the network options (X342n only)

Note: These menu items are only available when the USB cable is unplugged.

1 Press Menu.
2 Press A or ¥ repeatedly until NETWORK SETUP appears, and then press V.
3 Press A or ¥ repeatedly until one of the following appears:

* Enable DHCP
e TP Address
® Netmask

* Gateway

4 Press vV to make adjustments to any of the above items. After making the necessary
adjustments, press v and the printer will save your settings and return to the Ready prompt.

If no adjustments are made, press Back repeatedly to return to the Ready prompt.

Using the control panel menus
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Using the MFP software

Use this

Print Properties

To

Select the best print settings for the document you are
printing.

Presto! PageManager

¢ Scan, share, and organize photos and documents.
¢ View, edit, send, and back up files in many formats.

QLINK

* Scan to various applications.

¢ Configure additional applications for scanning. For more
information, see page 56.

¢ Customize scan settings. For more information, see
page 58.

Using Print Properties

Print Properties is the software that controls the printing function when the printer is connected to a
computer. You can change the settings in Print Properties based on the type of project you want to

create.

Opening Print Properties

You can open Print Properties from almost any program:

1 With a document open, click File > Print.

2 From the Print dialog, click Properties, Preferences, Options, or Setup.

Using the Print Properties tabs

Tab
Layout

Options

* Select the orientation of the document on the printed page:
portrait or landscape.

e Choose the order to print the pages.

* Choose the number of pages to print per sheet.

Paper/Quality

¢ Choose the paper source.
¢ Specify the type of paper loaded.

Watermark Add, edit, or remove a watermark.
Profiles Add personal profiles.
About Lists copyright and file versions.

Using the MFP software
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Using Presto! PageManager (USB attach only)

Use Presto! PageManager to scan, share, and organize photos and documents.

To open Presto! PageManager, click Start > Programs or All Programs >
Lexmark Applications > Presto! PageManager.

To access the Presto! PageManager Help:

1 Open Presto! PageManager.

2 Click Help > Help.

Using QLINK (USB attach only)

With QLINK, you can:
e Scan to various applications.
* Configure additional applications for scanning. For more information, see page 56.
e Customize scan settings. For more information, see page 58.
To open QLINK, use one of the following methods:
e From the MFP control panel, press Scan.
e Double-click the QLINK icon on the desktop.
e (Click Start > Programs or All Programs - Lexmark > Lexmark X34x Series > QLINK.

QLINK ]
Scan ko | MFP Display | Original Ima... | Original Size | Resolution |

@ Scan TaFile To File Phato Letter a0

L":i] Outlook Express Email Photo Letter 100

% Micrazoft Paint Paint Phaoto Letter 100

E= Acrobat Reader Acrobat Photo Letter 100

21 Micrazoft Word whord Fhato Letter 100

ﬁl Microzoft Excel Euxcel Photo Letter 100
Mew Application Scan Now u]

Using the MFP software
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0 Loading paper and original documents
\/—

Loading paper in the paper tray

1 Make sure:

* You use paper designed for laser printers.

e The paper is not used or damaged.

* If you are using specialty paper, you follow the instructions that came with the paper.
e You do not force paper into the MFP.

e Set the correct paper type in the control panel, or using the computer. For more
information, see Setting the paper type and size.

2 Remove the paper tray.

Loading paper and original documents
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3 Holding the tray on a stable surface, press the guide lock, and slide the rear guide until it
locks at the paper length you want.

Note: To load longer paper, such as legal size paper:

e Press the button at the back of the paper tray, and extend the tray until it locks
into place.

e Attach the dust cover to the rear of the MFP to protect the paper that extends
beyond the edge of the MFP.

4 Prepare a stack of paper for loading by flexing or fanning it back and forth. Straighten the
edges on a level surface.

Loading paper in the paper tray
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5 Load the paper with the print side facing down.

Note: Load letterhead paper with the design side facing down. The top edge of the sheet
should be placed at the front of the tray.

6 Make sure the paper is below the maximum fill lines on the left inside wall of the tray.

Note: Overloading paper may cause paper jams.

Loading paper in the paper tray
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7 Squeeze and adjust the paper guides until they lightly touch the side of the stack of paper.

Note: Do not push the paper guides far enough to cause the materials to warp. Incorrect
adjustments may cause paper jams.

8 Close the paper tray.

Note: The paper level indicator, on the front of the paper tray, shows the amount of paper
currently in the tray.

Note: If you experience problems with the paper feed, use the manual feeder. For more
information, see Loading paper in the manual feeder on page 32.

Loading paper in the paper tray
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Loading paper in the manual feeder

Use the manual feeder to print transparencies, labels, envelopes, or card stock. You may also use
the manual feeder to make short runs of paper types or sizes that are not currently loaded in the
paper tray.

For information on acceptable print media to use in the manual feeder, see Loading various paper
types on page 33.

1 Make sure:

* You use paper designed for laser printers.

e The paper is not used or damaged.

* If you are using specialty paper, you follow the instructions that came with it.
¢ You do not force paper into the MFP.

* Set the correct paper type and size in the control panel, or using the computer. For
more information, see Setting the paper type and size.

2 Place a single sheet of paper face-up with the leading edge first into the center of the manual
feeder, and adjust the paper guides to the paper width.

The MFP automatically engages the print media.

Loading paper in the manual feeder
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Loading various paper types

Size (mm/in.)

Input source/capacity’

250-sheet paper
tray

Manual feeder

550—sheet paper
tray (optional)

Plain paper

Letter (215.9 x 279/8.5 x 11)
A4 (210 x 297/8.27 x 11.69)
Folio (215.9 x 330.2/8.5 x 13)
Legal (215.9 x 355.6/8.5 x 14)

JISB5 (182 x 257/7.2 x 10)
Statement (140 x 216/5.5 x 8.5)
A5 (148 x 210/5.83 x 8.27)

Executive (184.2 x 266.7/7.25 x 10.5)

Yes/250

Yes/1

Yes/550

Envelopes?

No. 9 (98.4 x 225.4/3.88 x 8.88)
No. 10 (104.8 x 241.3/4.12 x 9.5)
DL (110 x 220/4.33 x 8.66)

C5 (162 x 229/6.38 x 9.02)

B5 (176 x 250/6.93 x 9.84)

No. 7 3/4 (98.4 x 190.4/3.88 x 7.5)

No/0

Yes/1

No/0

Paper labels®
Letter (215.9 x 279/8.5 x 11)
A4 (210 x 297/8.27 x 11.69)

No/0

Yes/1

No/0

Transparency films
Letter (215.9 x 279/8.5 x 11)
A4 (210 x 297/8.27 x 11.69)

Yes/50

Yes/1

Yes/50
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Input source/capacity’

250-sheet paper 550-sheet paper
Size (mm/in.) tray Manual feeder tray (optional)

Card stock* No/0 Yes/1 No/0
Letter (215.9 x 279/8.5 x 11)

A4 (210 x 297/8.27 x 11.69)

Folio (215.9 x 330.2/8.5 x 13)

Legal (215.9 x 355.6/8.5 x 14)
Executive (184.2 x 266.7/7.25 x 10.5)
JISB5 (182 x 257/7.2 x 10)
Statement (140 x 216/5.5 x 8.5)

A5 (148 x 210/5.83 x 8.27)

T Maximum capacity may be reduced depending on paper thickness.

2 Feed envelopes one sheet at a time through the manual feeder.

3 The MFP is intended for occasional paper label printing only. Feed one sheet at a time through the manual

feeder. Do not use vinyl labels with the MFP.

4 Feed card stock one sheet at a time through the manual feeder. It must exit through the rear output slot.
Individual postcard sizes, such as 4 x 6, are not supported. Lexmark recommends full-sized sheets of
postcard stock designed for laser printers.

Warning: Using unsupported media sizes may damage the MFP.

Loading various paper types
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Setting the paper type and size

Using the control panel
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Press Menu.

Press A or ¥ repeatedly until PAPER SETUP appears on the top line of the display, and
then press v/ .

Press A or ¥ repeatedly until size/Type appears on the top line of the display, and then
press /.

Press A or ¥ repeatedly until the paper source you want to use appears.

Press /.

Press A or ¥ repeatedly until the paper size you want to use is selected, and then press y/ .
Press A or ¥ repeatedly until the paper type you want to use is selected.

Press /.

To return to the Ready prompt, press Stop.

Note: If you are printing from the computer, continue with Using the control panel.

Using the computer
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With a document open, click File - Print.

Click Properties, Options, Setup, or Preferences.

From the Paper/Quality tab, select the paper type from the Media drop—down list.
Click the Advanced button.

Select the paper size.

Click OK.

Click OK.

Click OK.

Setting the paper type and size
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Loading original documents into the ADF

You can load up to 50 sheets of an original document into the ADF for scanning, copying, and faxing.

* Remove staples and paper clips from the original documents before loading
into the ADF.

e The ADF may not properly feed documents that are damaged or folded. If this
occurs, use the scanner glass. For more information, see Loading original
documents on the scanner glass on page 37.

1 Load an original document face-up into the ADF.

Note: Do not load postcards, 4 x 6 cards, small items, or thin media (such as magazine
clippings or carbonless paper) into the ADF. Place these items on the scanner
glass.

2 Adjust the paper guides on the ADF against the edges of the paper.

Note: If longer paper is used, extend the ADF paper support.

Loading original documents into the ADF
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Loading original documents on the scanner glass

You can scan, copy, and fax photos, text documents, magazine articles, newspapers, and other
publications.

Note: Place postcards, 4 x 6 cards, small items, or thin media (such as magazine
clippings or carbonless paper) on the scanner glass.

1 Open the top cover.

2 Place the document face-down on the scanner glass in the upper left corner.

Loading original documents on the scanner glass
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3 Close the top cover to avoid dark edges on the scanned image.

Selecting an output location

The MFP has two output locations: the front output tray and the rear paper exit.

Front output

tray Rear paper exit

Front output tray

The front output tray should be used to output plain paper only. Use the rear paper exit for envelopes,
labels, card stock, and transparencies. To use the front output tray, make sure the rear cover is
closed.

This tray should be used for most jobs and is recommended for jobs requiring over 50 sheets of plain
paper continuously.

Note: If problems, such as excessive curl, occur when using the front output tray, try using
the rear output slot.

Rear paper exit

You can use the rear paper exit for all paper types; however, for envelopes, labels, card stock, and
transparencies, using this slot is recommended. To use the rear paper exit, open the rear cover.

Paper is output face-up through the rear paper exit, with the last page on the top. To avoid paper
jams, do not open or close the rear cover while printing.

Selecting an output location
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9 Printing

\V -

Printing a document

Load paper.

With a document open, click File - Print.

Click Properties, Options, Setup, or Preferences.
Adjust the settings.

Click OK.

Click OK or Print.
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Printing an envelope

1 Load an envelope face-up in the manual feeder.
Note: Make sure the envelope flap is face-down.

2 With a document open, click File - Print.

Click Properties, Options, Setup, or Preferences.

From the Layout tab, select Landscape.

Note:

* Most envelopes use landscape orientation.
* Make sure the same orientation is also selected in the software application.

From the Paper/Quality tab, select the paper source.

Select Envelope from the Media drop-down list.

Click the Advanced button.

Select the envelope size loaded, and click OK.

Click OK.
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Printing
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Click OK or Print.

Printing transparencies

1
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Load transparencies.
Note:

* If you are using the manual feeder, load one transparency at a time.
e Make sure you use a transparency designed for laser printers.

With a document open, click File = Print.

Click Properties, Options, Setup, or Preferences.

From the Paper/Quality tab, select the paper source.

Select Transparency from the Media drop-down list.

Click the Advanced button.

Select the transparency size loaded, and click OK.

Click OK.

Click OK or Print.

Printing collated copies

If you print multiple copies of a document, you can choose to print each copy as a set (collated) or to
print the copies as groups of pages (not collated).
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Load paper.
With a document open, click File = Print.
From Copies, select the Collate check box.

Click OK or Print.

Printing multiple pages on one sheet

1
2
3

Load paper.
With a document open, click File = Print.

Click Properties, Options, Setup, or Preferences.

Printing transparencies
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4 From the Layout tab, select the number of pages per sheet from the Pages Per Sheet drop—
down list.

Click OK.
Click OK or Print.

Printing the last page first (reverse order)

Load paper.

With a document open, click File = Print.

Click Properties, Options, Setup, or Preferences.

From the Layout tab, select the Back to Front check box.
Click OK.

Click OK or Print.
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Printing the last page first (reverse order)
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a Faxing

You can load an original document into the ADF or on the scanner glass.

ADF

Scanner glass

Use the ADF for multiple—page documents.

glass.

Note: Do not load postcards, 4 x 6 cards, small items, or
thin media (such as magazine clippings or carbonless
paper) into the ADF. Place these items on the scanner

Use the scanner glass for single-page
documents, postcards, 4 x 6 cards, small
items, or thin media (such as magazine
clippings or carbonless paper).

Faxing
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Sending a fax

Note: Make sure the MFP is connected to an active, analog telephone line.

Sending a fax automatically

1 Make sure the MFP is on.

2 Load an original document face-up into the ADF or face-down on the scanner glass.

Note: Do not load postcards, 4 x 6 cards, small items, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

From the control panel, press Fax.

Enter a fax number, press Speed Dial 1, 2, 3, 4, or 5, or press Phone Book to select a
number.

Note:

e If you do not have a Speed Dial list but want to create one, see Setting up
shortcuts on page 47.

e |f you do not have a Phone Book list but want to create one, see Using the
Phone Book on page 48.

Press Start.

If prompted, press 1 (for yes) if you have more pages, or 2 (for no) if you have finished
scanning the entire document.

Sending a fax manually

Make sure the MFP is on.
Load an original document face-up into the ADF or face-down on the scanner glass.

From the control panel, press Fax.
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Press Z- to get a dial tone.

Sending a fax
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Enter a fax number, press Speed Dial 1, 2, 3, 4, or 5, or press Phone Book to select a
number.

Note:

e |f you do not have a Speed Dial list but want to create one, see Setting up
shortcuts on page 47.

e |f you do not have a Phone Book list but want to create one, see Using the
Phone Book on page 48.

When you hear the fax tone, press Start.
The control panel prompts you for another page.

If prompted, press 1 (for yes) if you have more pages, or 2 (for no) if you have finished
scanning the entire document.

Sending a fax to a group (broadcast fax)

You can send a fax to as many as 8 people at once.
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Note: You cannot save this group in the Phone Book.

Load an original document into the ADF or on the scanner glass.

From the control panel, press Fax.

Under Fax, press Options.

Press A or ¥ repeatedly until Broadcast appears, and then press V.
Press V.

Enter a fax number, and then press \/

Using the numeric keypad, press 1 (for Yes) if you have another number, or 2 (for No) if you
have entered the last number.

Sending a fax at a scheduled time (delay send)

Using the delay send feature, you can scan a document now and fax it at a later time.
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Load an original document into the ADF or on the scanner glass.

From the control panel, press Fax.

Under Fax, press Options.

Press A or ¥ repeatedly until Delay send appears, and then press V.
Press V.

Sending a fax
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Enter a fax number, and then press \/

Using the numeric keypad, press 1 (for Yes) if you have another number, or 2 (for No) if you
have entered the last number.

8 Enter the time you want to send the fax, and then press V.

Note: At the designated time, the fax numbers are dialed and the fax is sent to all of the
designated fax numbers. If the fax transmission is unsuccessful to any of the
numbers on the broadcast list, the unsuccessful numbers will be dialed again.

Adding a prefix before dialing

Using the prefix feature, you can dial an extension to reach an outside line or turn off call-waiting
before sending a fax.

From the control panel, press Menu.
Press A or ¥ repeatedly until Fax Defaults appears, and then press V.
Press A or ¥ repeatedly until Prefix appears, and then press V.

Enter the prefix you want to dial before sending a fax, and then press V.
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Press Stop to return to the Ready prompt.

Adding a pause while dialing

Using the pause feature, you can add a pause during dialing to wait for an outside line or navigate an
automated telephone system.

While dialing the fax number, press Redial/Pause to insert a pause. A pause is represented by a
comma (,) on the display.

Receiving a fax

Receiving a fax automatically

When the MFP is set to Auto Answer, it answers an incoming fax on a specified number of rings.
Once the connection is established, the MFP automatically receives the fax.

Receiving a fax
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Receiving a fax manually

We recommend using this feature when the fax and the telephone share a telephone line. Choose
which incoming faxes to accept by setting the MFP to manual answering mode.

1 Deselect Auto Answer:

a
b

Cc

f

From the control panel, press Fax.

Press Menu.

Press A or ¥ repeatedly until FAX ADVANCED appears, and then press V.
Auto Answer appears.

Press V.

Press ‘/A or ¥ repeatedly until No appears on the bottom line of the display, and then
press V.

To return to the Ready prompt, press Stop.

When the telephone rings, press Z-.

If you hear a fax tone, press Start.

The MFP receives the fax.

Forwarding faxes

Use the fax forwarding feature if you are going to be away but still want to receive faxes. There are
three fax forwarding settings:

Off—(Default)

Forward—The MFP sends the fax to the designated fax number.

Forward and Print—The MFP prints the fax and then sends it to the designated fax number.

Setting up fax forwarding
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From the control panel, press Fax.

Press Menu.

Press A or ¥ repeatedly until FAX ADVANCED is selected.
Press V.

Press A or ¥ repeatedly until Fax Forwarding is selected.

Press \/ .

Press A or ¥ repeatedly until Forward or Fwd. and Print is selected.

Forwarding faxes
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8 PressV.
9 Enter the number to which you want to forward the fax.
10 Press V.

Printing fax activity reports

From the control panel, press Fax.

Press Menu.

Press A or ¥ repeatedly until REPORTS is selected.

Press V.

Press A or ¥ repeatedly until Fax call log or Fax Job log is selected.
Press V.
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Customizing fax settings

Setting up shortcuts
To make sending faxes easier, you can enter up to 99 shortcuts.

From the control panel, press Fax.
Press Phone Book.
Press A or ¥ repeatedly until Edit is selected.

Press \/ .
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Add appears on the display.
Press V.

Enter the shortcut number (1-99), and then press V.
Note:

e Shortcuts do not have to be entered in order.

e Shortcuts 1-10 can be accessed through the Speed Dial buttons. For more
information, see Using the Speed Dial buttons on page 48.

Printing fax activity reports
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Enter the shortcut name using the keypad, and then press V. For more information, see
Entering characters on page 50.

Note: The MFP does not support double—byte characters for names, such as Chinese,
Japanese, or Korean. You cannot enter a name using these languages.

Enter a fax number, and then press V.

Using the numeric keypad, press 1 (for Yes) if you have another number, or 2 (for No) if you
are finished.

Using the Speed Dial buttons

You can access shortcuts 1-5 and 6—10 with the Speed Dial buttons. These buttons are
automatically programmed when you program shortcuts 1-10. For instructions on how to add
shortcuts to the Phone Book, see Setting up shortcuts on page 47.

Load an original document into the ADF or on the scanner glass.
From the control panel, press Fax.

Press a Speed Dial button.

a Press Speed Dial 1, 2, 3, 4, or 5 for the first five shortcuts.

b Press Shift, and then press Speed Dial 1, 2, 3, 4, or 5 for shortcuts 6—-10.
Note: Shift + Speed Dial 1 is shortcut 6. Shift + Speed Dial 2 is shortcut 7, and so on.

Press \/ .

Press Start.

Using the Phone Book

To access the Phone Book menu, press Phone Book.

Use this To

Edit

Edit an individual shortcut, create a new shortcut, or delete a shortcut.

Search Search for shortcuts by number or by name.

* To search by shortcut number, press # followed by the two—digit shortcut,
and then press /.

¢ To search by name, press the number that contains the first letter of the
desired shortcut name, and then press 4 or ¥ to scr\cyl through the
shortcuts. When the name you want is selected, press v .

Print

Print all shortcuts (1-99) listed in the Phone Book.

Customizing fax settings
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Setting the distinctive ring
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From the control panel, press Fax.

Press Menu.

Press A or ¥ repeatedly until FAX DEFAULTS is selected.
Press V.

Press A or ¥ repeatedly until Distinct Ring is selected.
Press V.

Press A or ¥ repeatedly until the setting you want is selected.
Press A or ¥ to turn the setting on or off.

Press V to save the setting.

Setting the Station ID

0 N OO a1 A WOON =

From the control panel, press Fax.

Press Menu.

Press A or ¥ repeatedly until FAX DEFAULTS is selected.

Press V.

Press A or ¥ repeatedly until station ID is selected.

Press V.

Enter the fax machine number, and press \/ to save.

Enter a name for the fax machine using the keypad, and then press v to save. For more
information, see Entering characters on page 50.

Note:

¢ The name for the fax machine should not exceed 20 characters.

e The MFP does not support double—byte characters for names, such as
Chinese, Japanese, or Korean. You cannot enter a name using these
languages.

Press Stop to return to the Ready prompt.

Customizing fax settings
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Entering characters

To enter a name for a fax job or the station ID, use the alphanumeric keypad. Press the appropriate
key repeatedly until the character you want to use appears on the display.

Note:

e Toadd a space, press Y.
e To go back a space, press A.

Key Characters

1@
ABCabc2
DEFdef3
GHlIghi4
JKLjkI5
MNOmMno6
PQRSpqrs?7
TUVtuvs8
WXYZwxyz9
0./+-+:;21<>()I[]

—

Ol iN[ojO|M~|[W| N

Canceling a fax job

Under Fax, press Options.
Press A or ¥ repeatedly until cancel appears on the top line of the display.
Press V.

Press A or ¥ repeatedly until you see the job that you want to cancel, and then press V.
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Press 1 to verify that you want to cancel the job or 2 to return to the menu.

Canceling a fax job
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0 Copying

You can load an original document into the ADF or on the scanner glass.

ADF

Scanner glass

Use the ADF for multiple—page documents.

Note: Do not load postcards, 4 x 6 cards, small items, or
thin media (such as magazine clippings or carbonless
paper) into the ADF. Place these items on the scanner
glass.

Use the scanner glass for single-page
documents, postcards, 4 x 6 cards, small
items, or thin media (such as magazine
clippings or carbonless paper).

Making a copy

1 Load paper.

Note: If you are using a paper size other than letter or A4, select the paper type and size
using the control panel. For more information, see Setting the paper type and

size on page 35.

Copying
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Load the original document face-up into the ADF or face-down on the scanner glass.
From the control panel, press Copy.

Enter the number of copies you want to print.
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Press Start.

Collating copies

If you make multiple copies of a document, you can choose to print each copy as a set (collated) or to
print the copies as groups of pages (not collated).

Load the original document face-up into the ADF or face-down on the scanner glass.
From the control panel, make sure Copy mode is selected.

Using the numeric keypad, enter the number of copies you want to print.

Under Copy, press Collate repeatedly until on appears.

Press ‘/
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Press Start.

Copying multiple pages onto a single sheet (Paper
Saver)

The Paper Saver feature lets you copy consecutive pages of a multiple-page document on a single
sheet of paper.

Load paper.

Load the original document face-up into the ADF or face-down on the scanner glass.
From the control panel, make sure Copy mode is selected.

Under Copy, press Options.

Press A or ¥ repeatedly until Paper Saver is selected, and then press V.
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Press A or ¥ repeatedly until the setting you want to use is selected.

Note:

2-Up—~Prints two copied documents on a page.
4-Up—~Prints four copied documents on a page.
Off—Prints one copied document on a page.

7 Press ‘/

Collating copies
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8 Press Start.

9 |If prompted, press 1 (for yes) if you have more pages, or 2 (for no) if you have finished
copying the number of pages you want to print in Paper Saver mode.

Enlarging or reducing an image
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Load paper.

2 Load an original document face-up into the ADF or face-down on the scanner glass.

Note: Do not load postcards, index cards, small items, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

From the control panel, make sure Copy mode is selected.

Press Scale repeatedly until the option you want appears.
Note: Choose custom to enter a specific percentage to enlarge or reduce.

Press \/ .

Press Start.

Enlarging or reducing an image
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0 Scanning

Using the X340, X340n, or X342n, you can send scanned images through the USB connection to

your computer. In addition, using the X342n you can scan the document back to your computer over

the network.

You can load an original document into the ADF or on the scanner glass.

ADF

Scanner glass

Use the ADF for multiple—page documents.

Note: Do not load postcards, 4 x 6 cards, small items, or
thin media (such as magazine clippings or carbonless
paper) into the ADF. Place these items on the scanner

glass.

Use the scanner glass for single-page
documents, postcards, 4 x 6 cards, small
items, or thin media (such as magazine
clippings or carbonless paper).

Scanning
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Scanning documents using the control panel (USB
attach only)

1 Make sure:

e The computeris on.
e The computer is attached to the MFP.
e The software has been loaded onto the computer.

2 Load an original document face-up into the ADF or face-down on the scanner glass.
Note: Do not load postcards, index cards, small items, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

From the control panel, press Scan.

Press A or ¥ repeatedly until the application you want to use appears.

Note:

e If you do not see the application you want to use, configure additional
applications for scanning. For more information, see Configuring additional
applications for scanning on page 56.

* Adjust the scan settings using the computer. For more information, see
Customizing scan settings on page 58.

5 Press Start.

The MFP scans the document.

6 If prompted, press 1 (for yes) if you have more pages, or 2 (for no) if you have finished
scanning the entire document.

Scanning documents using the computer (USB attach
only)

1 Make sure:

e The computeris on.
e The computer is attached to the MFP.
e The software has been loaded onto the computer.

2 Load an original document face-up into the ADF or face-down on the scanner glass.
3 Open QLINK:
e Double-click the QLINK icon on the desktop.

Scanning documents using the control panel (USB attach only)
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e (Click Start > All Programs > Lexmark > Lexmark X34x Series -> QLINK.

4 Select the application you want to use.

Note: If you do not see the application you want to use, configure additional applications
for scanning. For more information, see Configuring additional applications for
scanning on page 56.

If you want to adjust the scan settings, see Customizing scan settings on page 58.
Press Scan Now.

The MFP scans the document.

Configuring additional applications for scanning

Note: When QLINK is installed, it automatically selects available applications for
scanning.

1 Open QLINK:

e Double-click the QLINK icon on the desktop.
e (Click Start > All Programs > Lexmark > Lexmark X34x Series > QLINK

Click New Application.
Click Browse, and browse to the folder where the application is stored.
Select the application you want to use, and click Open.

Enter the program name.
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Enter the program name to appear on the display.

Note: You can also change your scan default settings for this application.

7 Click OK.

Scanning documents directly from an application (USB
attach only)

You can scan documents directly from applications that are TWAIN and WIA compliant. See the
application Help for more information.

Scanning documents directly from an application (USB attach only)
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Scanning text for editing (OCR)

Use the Optical Character Recognition (OCR) software feature to turn scanned images into text that
you can edit with a word-processing or spreadsheet application.

1

10
11

Make sure ABBYY FineReader is installed.

Note: ABBYY FineReader installs as part of the MFP software during initial setup. To
verify that it has been installed correctly, click Start > Programs or All
Programs > ABBYY FineReader 6.0 Sprint, and make sure that ABBYY
FineReader is listed.

Load an original document face-up into the ADF or face-down on the scanner glass.

Click Start > Programs or All Programs > Lexmark Applications >
Presto! PageManager.

PageManager appears with the Scan Buttons dialog.

3

OCE

77

PR

e/

From the Scan Buttons dialog, click

Note: If the Scan Buttons dialog does not appear, press F9.

From the Scan Manager dialog, click Preview.

Adjust the scan settings as desired.
Note: For best results, select Black and White instead of color.

Click Scan.

ABBYY FineReader appears.

From the toolbar, click Read.

Click Save.

Select a destination you want to send to, and click OK.

Edit and save the document.

Scanning text for editing (OCR)
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Customizing scan settings

1 Open QLINK:

e Double-click the QLINK icon on the desktop.
e (Click Start > All Programs > Lexmark > Lexmark X34x Series > QLINK.

Select the destination you want to scan to.
Click Edit.
Adjust the scan settings.

Click OK.

aa A~ W DN

Scanning over a network

Note: Only available on the X342n connected to a network

1 Type the IP address of the MFP in the address line of your browser, and then press Enter.

If the Java applet screen appears, click Yes.

Note: The IP address can be found on the network setup page. For more information, see
Printing a network setup page (X342n only)

Click Scan Profile.
Click Create Scan Profile.
Select your scan settings, and then click Next.

Select a location for saving the scanned output file somewhere on your computer.
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Enter a profile name.

The profile name is the name that will appear on the Scan Profile list on the MFP control
panel when the scan button is pressed.

Click Submit.
Review the instructions on the Scan to PC screen.

A shortcut number was automatically assigned when you clicked Submit. You can use this
shortcut number when you are ready to scan your documents.

a Go tothe MFP, and place your original document in the ADF face up, long edge first.

b Press # followed by the shortcut number on the keypad, or touch Profiles on the home
screen.

Scanning over a network
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¢ After you enter the shortcut number, the scanner will scan and send the document to the
directory or application you specified. If you touch Profiles on the home screen, locate
your shortcut on the list.

9 Return to your computer to view your file.

Your output file is saved in the location you specified or launched in the application you
specified.

Understanding Scan options

To change the options for the scan to PC Profile, you must click the Quick Setup box, and select
Custom. Quick Setup lets you select preset formats or customize your scan job settings. You can
select:

Custom Photo - Color JPEG
Text - BW PDF Photo - Color TIFF
Text - BW TIFF Text/Photo - BW PDF

Text/Photo - Color PDF

Format Type—Sets the output (PDF, TIFF, or JPEG) for the scanned image.
PDF output is a single file.

TIFF output is a single file. If Multi-page TIFF is turned off in the Configuration menu, then
TIFF saves one page each in a series of files.

JPEG saves one page in each file. When multiple pages are scanned, the output will be a
series of files.

Compression—Sets the compression format used to compress the scanned output file.

Default Content—Tells the MFP the original document type. Choose from Text, Text/Photo, or
Photo. Content affects the quality and size of your scanned file.

Text—Emphasizes sharp, black, high-resolution text against a clean, white background.

Text/Photo—Used when the original documents are a mixture of text and graphics or
pictures.

Photo—Tells the scanner to pay extra attention to graphics and pictures. This setting
emphasizes a reproduction of the full dynamic range of tones in the original document. This
increases the amount of information saved.

Color—Tells the MFP the color of the original documents. You can select Gray, BW (Black and
White), or Color.

Original Size—Opens a field where you can select the size of the document you are going to scan.
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Orientation—Tells the MFP whether the original document is portrait or landscape and then
changes the Sides and Binding settings to match the original document orientation.

Darkness—Adjusts how light or dark your scanned documents will turn out.

Resolution—Adjusts the output quality of your file. Increasing the image resolution increases the file

size and the time needed to scan your original document. Image resolution can be decreased to
reduce the file size.

Understanding Scan options
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9 Maintaining the MFP

Removing a toner cartridge

1 Press the access button on the left side of the MFP, and open the front cover.

.....
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2 To remove the toner cartridge:
a Press the button on the print cartridge assembly.

b Remove the toner cartridge using the handle.

To return the empty toner cartridge, see Recycling Lexmark products on page 70 for more
information.

Maintaining the MFP
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Installing a toner cartridge

1 If you are installing a new toner cartridge, remove the toner cartridge from the packaging, and
gently shake four or five times to distribute the toner.

’
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2 Gently slide the toner cartridge in until it locks into place.

Installing a toner cartridge
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3 Close the front cover.

Note: The front cover must be closed to start a new print, copy, scan, or fax job.

Redistributing toner

Redistribute the toner if you are dissatisfied with print quality or if the error message on the display is
88 Toner Low.

Note: If the error message reappears after redistributing the toner, replace the toner
cartridge. For more information, see Removing a toner cartridge on page 61 and
Installing a toner cartridge on page 62.

1 Press the access button on the left side of the MFP, and open the front cover.

Redistributing toner
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2 To remove the toner cartridge:
a Press the button on the print cartridge assembly.

b Remove the toner cartridge using the handle.

3 Firmly shake the cartridge in all directions to distribute the toner.
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4 Reinstall the cartridge, and close the front cover.

Note: If print quality does not improve, replace the toner cartridge.

Redistributing toner
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Replacing the photoconductor

1 Press the access button on the left side of the MFP, and open the front cover.

3 Place the print cartridge assembly on a flat, clean surface.

Replacing the photoconductor
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4 To remove the toner cartridge:
a Press the button on the print cartridge assembly.

b Remove the toner cartridge using the handle.

5 Unpack the photoconductor kit.

6 Install the toner cartridge into the new photoconductor.

Note: The toner cartridge snaps into place when correctly installed.

7 Reinstall the print cartridge assembly.
8 Press and hold Stop for three seconds to reset photoconductor recount.

9 Close the front cover.

Replacing the photoconductor
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Cleaning the MFP

To maintain print quality, follow these cleaning procedures each time the toner cartridge is replaced
or if print quality problems occur.

Warning: Do not put water directly on the MFP or use ammonia—based cleaners or volatile
solvents, such as paint thinner, on the MFP.

Cleaning the scanner glass
1 Slightly dampen a soft, lint—free cloth or paper towel with water.

2 Open the top cover.

3 Wipe the surfaces of the scanner glass and ADF until they are clean and dry.

4 Wipe the underside of the white top cover and white sheet until it is clean and dry.

5 Close the top cover.

Cleaning the outside of the MFP

Wipe the outside surface of the MFP with a soft, clean, lint—free cloth. If you dampen the cloth slightly
with water, be careful not to let any water drip onto or inside the MFP.

Cleaning the MFP
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Cleaning the inside of the MFP

CAUTION: The fuser area is hot. Avoid contact with the fuser area to prevent burns.

A\

Warning: While cleaning the inside of the MFP, be careful not to touch the transfer roller
located under the toner cartridge. Oil from your fingers can affect print quality.

1 Turn the MFP off, unplug the power cord, and then wait for the MFP to cool down.

2 Open the front cover, and pull on the handle to remove the print cartridge assembly.

Warning: Do not touch the green photoconductor drum.

3 Place the print cartridge assembly on a clean, dry surface.

Cleaning the MFP
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4 With a dry, lint—free cloth, wipe away any dust and spilled toner from the print cartridge area.

Warning:

* To prevent damage to the print cartridge assembly, do not expose it to light for
more than a few minutes. Cover it with a piece of paper, if necessary.

¢ Do not touch the black transfer roller.

5 Reinsert the print cartridge assembly, and close the front cover.

6 Plug in the power cord and turn the MFP on.

Cleaning the MFP
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Ordering supplies

To order supplies or to locate a dealer near you, visit our Web site: www.lexmark.com.

Part number Item Average yield

X340A11G Return program toner cartridge 2500 standard pages1
(X340/X340n/X342n)

X340H11G High yield return program toner cartridge (X342n) | 6000 standard pages1

X340H22G Photoconductor kit Up to 30,000 pages2

X340A21G Toner Cartridge (X340/X340n/X342n) 2500 standard pages1

X340H21G High yield toner cartridge (X342n) 6000 standard pages1

1 Declared yield value in accordance with ISO/IEC 19752.

2 Based on approximately 5% coverage.

Recycling Lexmark products

To return Lexmark products to Lexmark for recycling:

1 Visit our Web site: www.lexmark.com/recycle.

2 Follow the instructions on the computer screen.

Ordering supplies
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Setup troubleshooting

Incorrect language appears on Press Menu.

the display. Press A or W repeatedly until MACHINE SETUP appears on the display.
Press \/ .

Press A or V¥ repeatedly until Language appears on the display.

Press \/ .

Press A or V¥ repeatedly until the language you want appears on the
display.

Press \/ .
Press Back repeatedly to return to the Ready prompt.

Turn off the MFP.

Disconnect the power supply cord from the wall outlet, and then from the
MFP.

3 Plug the cord all the way into the MFP.

4 Plug the cord into an electrical outlet that other electrical devices have
been using.

5 Turn on the MFP.

Software will not install. If the software does not launch automatically when you insert the CD:

D O A WODN =

Display is not lit.
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1 Close all open software applications.
2 Temporarily disable any anti—virus programs.
3 Double—click the My Computer icon.
For Windows XP, click Start to access the My Computer icon.
4 Double—click the CD—ROM drive icon.
5 If necessary, double—click setup.exe.
6 Follow the instructions on the computer screen to install the software.

Note: After installing the software, be sure to re—enable your anti—virus
software.

1 Remove the software CD.

2 Turn off the computer.

3 Restart the computer.

4 When the desktop appears, reinsert the software CD.
5 Follow the instructions on the computer screen.

If the MFP is connected to the computer through another device:

1 Disconnect the USB cable from any other device such as a USB hub or
switch box.

2 Directly connect the cable to the MFP and the computer.

Setup troubleshooting
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Solution

Symptom

Unable to connect over a
network

Make sure you are using the correct cable, that it is securely connected, and
the network options are properly configured.

For more information, see Setting the network options (X342n only).
Note: Connecting over a network is only available on the X342n.
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Removing and reinstalling the drivers software

If the software is not functioning properly or a communications error message appears, you may
need to remove and then reinstall the drivers software. If the problems persist, follow these steps:

Note: Before reinstalling, shut down and restart the computer.

Disconnect the USB cable from the computer.

From the desktop, click Start > Programs > Lexmark > Lexmark Software Uninstall.
Follow the instructions on the computer screen to remove the software.

Restart the computer.

If any Add New Hardware screens appear, click Cancel.
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Eject and reinsert the software CD.
7 Reconnect the USB cable to the computer.

If the software installation screen does not appear:

1 From the desktop, double-click My Computer.
For Windows XP, click Start to access the My Computer icon.
Double-click the CD—ROM drive icon. If necessary, double-click setup.exe.
When the MFP software installation screen appears, click Install or Install Now.

Follow the instructions on the computer screen to complete the installation.

Setup troubleshooting
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Jams and misfeeds troubleshooting

Follow these tips to help prevent document and paper jams.

e Use only recommended print materials.

e Do not mix paper types in the paper tray.

¢ Do not use creased, damp, or curled paper.

* Flex, fan, and straighten the paper before loading.

e Make sure the adjustable paper guides are positioned correctly.

* Make sure the recommended print side has the correct orientation when loading paper in the
paper tray and the manual feeder.

¢ Do not overload the paper tray. The paper should be below the max fill line on the inside wall

of the paper tray.

* Do not remove the paper from the tray while printing.

Symptom Solution

Paper jam

Clear the paper jam. See Clearing a paper jam on page 76.

Paper or specialty media

¢ Misfeeds or skews

* Multiple sheets stick
together.

Load a smaller amount of paper into the MFP. See Loading various paper
types on page 33 for more information about maximum loading amounts for
each paper type.

Use only new, unwrinkled paper.

Prepare the stack of paper for loading by flexing or fanning it back and forth.
Straighten the edges on a level surface

Paper does not feed.

Make sure paper is loaded correctly. For more information, see Loading
paper and original documents on page 28.

Load a smaller amount of paper into the MFP. See Loading various paper
types on page 33 for more information about maximum loading amounts for
each paper type.

Paper stacks poorly in the
front output slot.

Extend the paper stop.

Do not let too much paper stack up in the front output slot.

Envelopes skew or fail to feed
correctly.

Insert a single envelope in the manual feeder, and make sure the guides are
against both sides of the envelope.

Jams and misfeeds troubleshooting
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Clearing a paper jam

Use the following table to locate and clear the paper jam.

Note: To avoid tearing the paper, pull the paper out gently and slowly.

Message Location of jam Go to...
200.xx Paper Jam MFP input sensor 200/201 Paper Jam on page 77
201.xx Paper Jam Be_tween MFP input and

exit sensors
202.xx Paper Jam Paper exit sensor 202 Paper Jam on page 80
241.xx Paper Jam Tray 1 241/242 Paper Jam on page 81
242.xx Paper Jam Tray 2
251.xx Paper Jam Manual Feeder 251 Paper Jam on page 82

290 Scanner Jam

ADF

291 Scanner Jam

292 Scanner Jam

290/291/292 Scanner Jam on
page 83

Note: xx represents numbers specific to the jam.

Jams and misfeeds troubleshooting
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200/201 Paper Jam

CAUTION: The fuser area is hot. Avoid contact with the fuser area to prevent burns.

A\

1 Press the access button on the left side of the MFP, and open the front cover.

Warning: Do not leave the print cartridge assembly exposed to direct light for an extended
period of time. Extended light exposure can cause print quality problems.
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3 Remove the jammed paper by gently pulling it straight out.
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5 Close the front cover.

6 Press Start to resume printing.

Note: If you receive a 200.20 paper jam at the start of a print job, verify that the media
settings match the acutal media size.
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202 Paper Jam

CAUTION: The fuser area is hot. Avoid contact with the fuser area to prevent burns.

A\

1 Open the rear cover.

3 Close the rear cover.

4 Press Start to resume printing.

Jams and misfeeds troubleshooting
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241/242 Paper Jam
1 Open the appropriate paper tray.
Note:

e Open Tray 1 for 241 Paper Jam. Open Tray 2 for 242 Paper Jam.
e 242 Paper Jam Will only occur when Tray 2 is installed.
e Tray 2 is optional and may be purchased separately.
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3 Insert the paper tray.

4 Press Start to resume printing.

Note: If you receive a 241.18 paper jam at the start of a print job, verify that the media
settings match the acutal media size.

251 Paper Jam

1 Remove the jammed paper by gently pulling it straight out of the MFP.

2 Press Start to resume printing.

Jams and misfeeds troubleshooting
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290/291/292 Scanner Jam

1 Open the ADF top cover.

2 Remove the jammed paper by gently pulling it straight out.

3 Close the ADF top cover, and then load the documents back into the ADF.

Note: To prevent document jams, use the scanner glass rather than the ADF for thick,
thin, or a mixed set of documents.

4 Press Start to resume.

Jams and misfeeds troubleshooting
83



Print and copy troubleshooting

Problem Solution

MFP does not print or See Display is not lit. on page 72.
respond

Remove and reinstall the software. For more information, see on page 73.

If you are scanning a document, wait until scanning is complete before
using the MFP.

Restart the computer.

Make sure the MFP is set as the default printer.
1 Click Start > Settings - Printers and Faxes or Printers.
or

Click Start > Control Panel - Printers and Other Hardware >
Printers and Faxes.

2 Double—click the Lexmark X340/X340n/X342n icon.

3 Click Printer, and make sure no check mark appears next to Pause
Printing.

4 Make sure a check mark appears next to Set As Default.

Make sure the front cover is closed.

Make sure the toner cartridge is installed correctly. For more information,
see Installing a toner cartridge on page 62.

Disconnect the USB cable, and then reconnect it.

Print speed is slow. Close all applications not in use.

Minimize the number and size of graphics and images in the document.

If you are using the manual feeder, this is normal.

Print and copy troubleshooting
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Print quality troubleshooting

Problem Solution

Light or faded print You may be able to temporarily extend the toner cartridge life by
redistributing the toner. For more information, see Redistributing toner on
AatbCc page 63.
AabCe Install a ne i i [ i
w toner cartridge. For more information, see Installing a toner
Aa=bCc cartridge on page 62.
AabCce Only use new, dry paper.
Aa=bCc

Make sure the front door is securely latched on both sides.

For copies, adjust the darkness settings by pressing Darkness from the
control panel.

For prints, adjust the darkness settings from the control panel menu:
1 From the control panel, press Menu.

2 Press A or V¥ repeatedly until MACHINE SETUP appears.
3 Press /.
4 Press A or V¥ repeatedly until Toner Dark appears.
5 Press /.
6 Press A or V¥ repeatedly to adjust the darkness settings.
7 Press |/ to save the settings.
8 Press Back repeatedly to return to the Ready prompt.
Toner specs Replace the toner cartridge. For more information, see Installing a toner
g 9
'.AAE.i oy C.C' cartridge on page 62.
AaBbCe Clean the inside of the MFP. For more information, see Cleaning the
:A.a- - CC inside of the MFP on page 68.
AaBbCc
Print irregularities Use only new, dry paper.
AaBbCc You may be able to temporarily extend the toner cartridge life by
S redistributing the toner. For more information, see Redistributing toner on
AaBbCc distributing the t F f t Redistributing t
\aBbC page 63. if this does not work, install a new print cartridge. For more
/p\\aBbCC information, see Installing a toner cartridge on page 62.
an Cc
AaBb(Cc
Vertical lines Replace the photoconductor. For more information, see Replacing the

photoconductor on page 65.

AaBbCq

/
AaBbCq You may be able to temporarily extend the toner cartridge life by

- redistributing the toner. For more information, see Redistributing toner on
AaBbCc page 63. if this does not work, install a new toner cartridge. For more
AaBbCa information, see Installing a toner cartridge on page 62.
/

AaBbCa

F—F—<

Print quality troubleshooting
85



Problem Solution

Horizontal stripes

Replace the toner cartridge. For more information, see Installing a toner

N cartridge on page 62.
AabbUC
AaBbCc
AaBbCc
AaBbCc
A~DLMNA
AabouC
Gray background For copies, adjust the darkness settings by pressing Darkness from the
control panel.
AaBbCc , : ,
AaBbCc For prints, adjust the darkness settings from the control panel menu:
AaBbCc 1 From the control panel, press Menu.
AaBbCc 2 Press A or V¥ repeatedly until MACHINE SETUP appears.
AaBbCc 3 Press /.
4 Press A or V¥ repeatedly until Toner Dark appears.
5 Press /.
6 Press A or V¥ repeatedly to adjust the darkness settings.
7 Press \/ to save the settings.

8 Press Back repeatedly to return to the Ready prompt.

Replace the toner cartridge. For more information, see Installing a toner
cartridge on page 62.

Toner smear

Clean the inside of the MFP. For more information, see Cleaning the
inside of the MFP on page 68.

AaBbCc , :
AaBbCc Make sure that the paper type settings match the paper in the tray. For
more information, see Setting the paper type and size on page 35.
Aa3bCc
ARHOCe
AQ Replace the toner cartridge. For more information, see Installing a toner
cartridge on page 62.
Page skew Make sure the paper guides in the tray are aligned with the edges of the
A paper. For more information, see Loading paper in the paper tray on
aBbCC page 28.
AaBbhc ; . :
AaBb c Make sure the paper guides for the manual feeder are aligned with the
A CC edges of the paper. For more information, see Loading paper in the
A aBbCC manual feeder on page 32.
aBbc
c
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Problem

Solution

Wrinkles or creases

Make sure paper is loaded correctly. For more information, see Loading
paper and original documents on page 28.

Make sure the paper is not too wet. Keep paper in its original wrapper and
out of high humidity areas until needed. Try paper from a freshly opened
pack.

Black pages

Replace the toner cartridge. For more information, see Installing a toner
cartridge on page 62.

If replacing the toner cartridge does not correct the problem, replace the
photoconductor. For more information, see Replacing the
photoconductor on page 65.

The MFP may need to be serviced. Call a service representative.

Print quality troubleshooting
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Scan troubleshooting

Problem Solution

Scanner does not respond Check the display. If there is an error message, see Error messages
troubleshooting on page 91.

Make sure the MFP is set as the default printer and is not on hold or paused.
1 Click Start > Settings - Printers and Faxes or Printers.
or

Click Start > Control Panel > Printers and Other Hardware >
Printers and Faxes.

2 Double—click the Lexmark X340/X340n/X342n icon.

3 Click Printer, and make sure no check mark appears next to Pause
Printing.

4 Make sure a check mark appears next to Set As Default.

If you are printing a document, wait until printing is done before sending the
scan job.

Scans very slowly Close all applications not in use.

If you are printing a document, wait until printing is done before sending the
scan job.

To change the scanning resolution to a lower value:
1 From the control panel, press Scan.

2 From the QLINK dialog on the computer screen, select the location you
want to use.

Click Edit.

Under Resolution, select a lower number.
Click OK.

Click Scan Now.
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Scan was unsuccessful. Restart the computer.

Remove and reinstall the software. For more information, see Removing
and reinstalling the drivers software on page 74.

Partial document scans Make sure the document is loaded correctly into the ADF or on the scanner
glass. For more information, see Scanning on page 54.

Make sure that the paper size settings match the paper in the tray. For more
information, see Setting the paper type and size on page 35.

Scan troubleshooting
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Fax troubleshooting

Problem Solution

Cannot send or receive a fax | Check the display. If there is an error message, see Error messages
troubleshooting on page 91.

Make sure cable connections for the following hardware are secure, if
applicable:

e Power supply

¢ Telephone

* Handset

* Answering machine

Check the telephone wall jack.

1 Plug a telephone into the wall jack.

2 Listen for a dial tone.

3 If you do not hear a dial tone, plug a different telephone into the jack.

4 If you still do not hear a dial tone, connect the printer to a different
telephone jack.

Place a test call to the telephone number to which you want to send a fax to
make sure that it is working correctly.

If the telephone line is being used by another device, wait until the other
device is finished before sending a fax.

To ensure the printer is working correctly, connect it directly to the telephone
line. Disconnect any answering machines, computers with modems, or
telephone line splitters.

Check for and clear any paper jams.

Call Waiting can disrupt fax transmissions. Disable this feature before
sending or receiving a fax. Call your telephone company to obtain the
keypad sequence for temporarily disabling Call Waiting.

Can send but not receive faxes | Load paper to print any faxes that have been stored in the printer.

Check to see whether Fax Forwarding is selected.

From the control panel, press Fax.

Press Menu.

Press & or ¥ repeatedly until FAX ADVANCED appears.
Press \/ .

Press & or ¥ repeatedly until Fax Forwarding appears.
Press \/ .

Press & or ¥ repeatedly until Of£ appears.

Press \/ .
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Problem Solution

Can receive but not send faxes | Make sure the document is loaded correctly into the ADF or on the scanner
glass. For more information, see Faxing on page 42.

Check the Prefix setting.

From the control panel, press Fax.

Press Menu.

Press & or ¥ repeatedly until FAX DEFAULTS appears.
Press \/ .

Press & or ¥ repeatedly until Prefix appears.

Press \/ .

Enter the numbers you would like to have dialed before each telephone
number.

8 Press \/ .
9 Press Stop to return to the Ready prompt.

N o g hsh ON =

If you used a Speed Dial button:

e Check to make sure it has been programmed for the number that you
wish to dial. For more information, see Setting up shortcuts on
page 47.

¢ As an alternative, dial the telephone number manually.

MFP receives a blank fax Ask the sender to verify the original document was loaded correctly.

Check the toner cartridge, and replace it if necessary.

Received fax has poor quality | Ask that the sender:

* Check that the quality of the original document is satisfactory.

* Resend the fax. There may have been a problem with the quality of the
telephone line connection.

¢ Increase the fax scan resolution.

Fax troubleshooting
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Error messages troubleshooting

Problem Solution

Change Media Press 1 to change the size and/or type of media, or press 2 to ignore the
error message.

Note: To continue the job, press Start. To cancel the job, press Stop.

Close Front Door Close the front cover until it locks.

Load Manual Load print media into the manual feeder. For more information, see
Loading paper in the manual feeder on page 32.

Load Media Load paper in the paper tray. For more information, see Loading paper
in the paper tray on page 28.

USB Not Connected Check the USB connection at the MFP and at the computer.

QLINK Not Found Restart the computer.

If the error message still appears after restarting the computer:
1 Insert the Software and Documentation CD.
2 Install the QLINK software.

Digital Line Detected Make sure the MFP is connected to an analog telephone line.

No dial tone Make sure cable connections for the following hardware are secure, if
applicable:

e Power supply

¢ Telephone

¢ Handset

¢ Answering machine

Check the telephone wall jack.

1 Plug a telephone into the wall jack.

2 Listen for a dial tone.

3 If you do not hear a dial tone, plug a different telephone into the jack.

4 If you still do not hear a dial tone,connect the printer to a different
telephone jack.

Line Busy Place a test call to the telephone number to which you want to send a
fax to make sure that it is working correctly.

No answer

Fax failed Resend the fax. If the fax still fails, see Cannot send or receive a fax
on page 89.

Scanner Locked, Unlock 1 Open the top cover.

Scanner 2 Move the switch to the left of the scanner glass to the unlock position.

31 Defective Print Remove the defective toner cartridge, and install a new Lexmark toner

Cartridge cartridge. For supplies information, see on page 69.

32 Unsupported Print
Cartridge

33 Change Cartridge

Error messages troubleshooting
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Problem Solution

34 Short paper

Make sure the correct media type and size have been selected for the
existing print job. For more information, see Setting the paper type
and size on page 35.

¢ Press Start to resume printing

Note: Pressing Start may truncate the print job.
or

¢ Press Stop to cancel the job.

Note: You cannot cancel an incoming fax.

37 Insufficient Collation
Area

38 Memory Full

The MFP does not have enough memory to process the job.
* Press Start to resume printing
or
¢ Press Stop to cancel the job.
Note:

¢ Clearing the error message in this way may cause some of the job
to be lost.
* You cannot cancel an incoming fax.

If possible, break larger jobs into smaller jobs.

Turn Collate off. For more information, see Printing collated copies on
page 40.

84 Photoconductor Near
Life

Press Start to clear the message and return to the previous status.

Press Stop to cancel the job.
Note: You cannot cancel an incoming fax.

Replace the photoconductor. For more information, see Replacing the
photoconductor on page 65.

84 Replace Photoconductor

Replace the photoconductor. For more information, see Replacing the
photoconductor on page 65.

Note: Normal printing will not resume until the photoconductor has
been replaced.

88 Toner Low

Press Start to resume printing.

Press Stop to cancel the job.

Extend the life of the toner cartridge by redistributing the toner. For more
information, see Redistributing toner on page 63.

If the error message reappears after redistributing the toner, replace the
toner cartridge. For more information, see Installing a toner cartridge
on page 62.

200.xx Paper Jam

201.xx Paper Jam

See 200/201 Paper Jam on page 77.

202.xx Paper Jam

See 202 Paper Jam on page 80.
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Problem Solution

241.xx Paper Jam See 241/242 Paper Jam on page 81.

242 .xx Paper Jam

251.xx Paper Jam See 251 Paper Jam on page 82.
290 Scanner Jam See 290/291/292 Scanner Jam on page 83.

291 Scanner Jam

292 Scanner Jam

9** xx Service 1 Turn the power off for one minute.
2 Turn the power on.

If the error message reappears, call a Lexmark service representative.
For authorized service representatives in your area, visit
www.lexmark.com.

Error messages troubleshooting
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Electronic emission notices

Federal Communications Commission (FCC) compliance information statement
Part 15

The Lexmark X340 (7003-100), X340n (7003-x050), and X342n (7003-110) have been tested and found to
comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. Operation is subject to
the following two conditions: (1) this device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause undesired operation.

The FCC Class B limits are designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If
this equipment does cause harmful interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult your point of purchase or service representative for additional suggestions.

The manufacturer is not responsible for any radio or television interference caused by using other than
recommended cables or by unauthorized changes or modifications to this equipment. Unauthorized changes
or modifications could void the user's authority to operate this equipment.

Note: To assure compliance with FCC regulations on electromagnetic interference for a Class B computing
device, use a properly shielded and grounded cable such as Lexmark part number 12A2405 for USB attach.
Use of a substitute cable not properly shielded and grounded may result in a violation of FCC regulations.

Any questions regarding this compliance information statement should be directed to:
Director of Lexmark Technology & Services
Lexmark International, Inc.
740 West New Circle Road
Lexington, KY 40550
(859) 232-3000

Part 68

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the Administrative
Council for Terminal Attachments (ACTA). On the back of this equipment is a label that contains, among other
information, a product identifier in the format US:AAAEQ##TXXXX. If requested, this number must be provided
to your telephone company.

This equipment uses the RJ—-11C Universal Service Order Code (USOC) jack.

A plug and jack used to connect this equipment to the premises’ wiring and telephone network must comply
with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant telephone cord and
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modular plug is provided with this product. It is designed to be connected to a compatible modular jack that is
also compliant.

The Ringer Equivalence Number (REN) is used to determine the number of devices that may be connected to
a telephone line. Excessive RENs on a telephone line may result in the devices not ringing in response to an
incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the
number of devices that may be connected to a line, as determined by the total RENs, contact your local
telephone company. For products approved after July 23, 2001, the REN for this product is part of the product
identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN without a
decimal point (for example, 03 is a REN of 0.3). For earlier products, the REN is shown separately on the label.

If this equipment causes harm to the telephone network, the telephone company will notify you in advance that
temporary discontinuance of service may be required. If advance notice is not practical, the telephone
company will notify the customer as soon as possible. You will also be advised of your right to file a complaint
with the FCC.

The telephone company may make changes in its facilities, equipment, operations or procedures that could
affect the operation of this equipment. If this happens, the telephone company will provide advance notice in
order for you to make necessary modifications to maintain uninterrupted service.

If you experience trouble with this equipment, for repair or warranty information, contact Lexmark International,
Inc. at www.Lexmark.com or your Lexmark representative. If the equipment is causing harm to the telephone
network, the telephone company may request that you disconnect the equipment until the problem is
resolved.This equipment contains no user serviceable parts. For repair and warranty information, contact
Lexmark International, Inc. See the previous paragraph for contact information.

Connection to party line service is subject to state tariffs. Contact the state public utility commission, public
service commission, or corporation commission for information.

If your home has specially wired alarm equipment connected to the telephone line, ensure the installation of
this equipment does not disable your alarm equipment. If you have questions about what will disable alarm
equipment, consult your telephone company or a qualified installer.

Telephone companies report that electrical surges, typically lightning transients, are very destructive to
customer terminal equipment connected to AC power sources. This has been identified as a major nationwide
problem. It is recommended that the customer install an appropriate AC surge arrestor in the AC outlet to which
this device is connected. An appropriate AC surge arrestor is defined as one that is suitably rated, and certified
by UL (Underwriter's Laboratories), another NRTL (Nationally Recognized Testing Laboratory), or a recognized
safety certification body in the country/region of use. This is to avoid damage to the equipment caused by local
lightning strikes and other electrical surges.

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other
electronic device, including fax machines, to send any message unless said message clearly contains in a
margin at the top or bottom of each transmitted page or on the first page of the transmission, the date and time
it is sent and an identification of the business or other entity, or other individual sending the message, and the
telephone number of the sending machine or such business, other entity, or individual. (The telephone number
provided may not be a 900 number or any other number for which charges exceed local or long—distance
transmission charges.)

See the section in this publication entitled Setting the Station ID on page 49 in order to program this
information into your fax machine.

Industry Canada compliance statement

This Class B digital apparatus meets all requirements of the Canadian Interference—Causing Equipment
Regulations.

Avis de conformité aux normes de I'industrie du Canada

Cet appareil numérique de la classe B respecte toutes les exigences du Reglement sur le matériel brouilleur
du Canada.
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European Community (EC) directives conformity

Declaration of Conformity with Regard to the EU Directive 1999/5/EC (R&TTE Directive) in languages of the
European Community.

English Hereby, Lexmark International Inc., declares that this product is in compliance with the
essential requirements and other relevant provisions of Directive 1999/5/EC.

Suomi Valmistaja Lexmark International Inc. vakuuttaa téaten, ettd taman tuotteen tyyppinen
laite on direktiivin 1999/5/EY oleellisten vaatimusten ja sit koskevien direktiivin
muiden ehtojen mukainen.

Nederlands Hierbij verklaart Lexmark International Inc. dat dit product in overeenstemming is met
de essentiéle eisen en de andere relevante bepalingen van richtlijn 1999/5/EG.

Bij deze verklaart Lexmark International Inc. dat dit product voldoet aan de essentiéle
eisen en aan de overige relevante bepalingen van richtlijn 1999/5/EG.

Francais Par la présente Lexmark International Inc. déclare que le produit est conforme aux
exigences essentielles et aux autres dispositions pertinentes de la directive 1999/5/
CE

Par la présente, Lexmark International Inc. déclare que ce produit est conforme aux
exigences essentielles et aux autres dispositions de la directive 1999/5/CE qui lui sont
applicables

Svenska Harmed intygar Lexmark International Inc. att denna produkt star i dverensstdmmelse
med de vasentliga egenskapskrav och dvriga relevanta bestimmelser som framgar av
direktiv 1999/5/EG.

Dansk Undertegnede Lexmark International Inc. erkleerer herved, at falgende produkt
overholder de veaesentlige krav og evrige relevante krav i direktiv 1999/5/EF

Deutsch Hiermit erkléart Lexmark International Inc., dass sich dieses Produkt in
Ubereinstimmung mit den grundlegenden Anforderungen und den anderen relevanten
Vorschriften der Richtlinie 1999/5/EG befindet. (BMWi)

Hiermit erklart Lexmark International Inc. die Ubereinstimmung des Produkts mit den
grundlegenden Anforderungen und den anderen relevanten Festlegungen der
Richtlinie 1999/5/EG. (Wien)

Me tnv TTapouca Lexmark International Inc. dnAwvel 611 To TTapdv TTPOIdV
CUNMPOPQWVETAI TTPOG TIG OUCIWOEIG ATTAITHOEIG KAl TIG AOITEG OXETIKEG DIATALEIG TNG
EAMnvika odnyiag 1999/5/EK.

Italiano Con la presente Lexmark International Inc. dichiara che questo prodotto &€ conforme ai
requisiti essenziali e alle altre disposizioni pertinenti stabilite dalla direttiva 1999/5/CE.

Espaniol Por medio de la presente Lexmark International Inc. declara que este producto
cumple con los requisitos esenciales y cualesquiera otras disposiciones aplicables o
exigibles de la Directiva 1999/5/CE

Portugués A Lexmark International Inc. declara que este produto esta em conformidade com os
requisitos essenciais e outras provisdes da Directiva 1999/5/CE.

Eesky Spoleénost Lexmark International Inc. timto prohlasuje, Ze tento vyrobek vyhovuje
zakladnim pozadavkum a dal§im ustanovenim smirnice 1999/5/EC, které se na tento
vyrobek vztahuiji.
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Malti

B'dan il-mezz, Lexmark International Inc., tiddikjara li dan
il-prodott huwa konformi mar-rekwiziti essenzjali u
ma' dispozizzjonijiet ohra rilevanti tad-Direttiva 1999/5/KE.

Magyar

A Lexmark International Inc. ezennel kijelenti, hogy ez a termék megfelel az 1999/5/
EC direktiva alapvetd kdvetelményeinek és mas vonatkozo rendelkezéseinek.

Eesti

Ké&esolevaga kinnitab Lexmark International Inc. selle seadme vastavust direktiivi
1999/5/EU pdhinduetele ja nimetatud direktiivist tulenevatele teistele asjakohastele
satetele.

Latviski

Ar 8o Lexmark International Inc. deklarg, ka dis produkts atbilst Direktivas 1999/5/EK
batiskajam prasibam un citiem ar to saistitajiem noteikumiem.

Lithuanian

Lexmark International Inc. deklaruoja, kad Sis gaminys tenkina 1999/5/EB Direktyvos
esminius reikalavimus ir kitas Sios direktyvos nuostatas.

Polski

Firma Lexmark International Inc. deklaruje z pe3n' odpowiedzialnoceci’, ¢ e ten
produkt spenia podstawowe wymagania i odpowiada warunkom zawartym w
dyrektywie 1999/5/WE.

Slovak

Lexmark International Inc. tymto vyhlasuje, Ze tento vyrobok vyhovuje technickym
poziadavkam a ialSim ustanoveniam smernice 1999/5/ES, ktoré sa na tento vyrobok
vztahuju.

Slovenséina

Druzba Lexmark International Inc. s tem izjavlja, da je ta naprava skladna z bistvenimi
zahtevami in drugimi ustreznimi doloeili direktive 1999/5/EC.

This product is in conformity with the protection requirements of EC Council directives 89/336/EEC, 73/23/
EEC, and 1999/5/EC on the approximation and harmonization of the laws of the Member States relating to

electromagnetic compatibilityand safety of electrical equipment designed for use within certain voltage limits
and on radio equipment andtelecommunications terminal equipment. The Official Declaration of Conformity

may be viewed at www.lexmark.com/rtte.

Compliance is indicated by the following CE marking:

q3

This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.

Japanese VCCI notice

BRICZOT—IPRRSNTNDIHEE, Vel
ROBHEBLTVET,

COBEE. HRLBEESEREEDERMHRR(VCCHDRES
3 HSRBEBHHEETT, COBEE, RERBTHEATSC
LEEMELTOETR, CORENS UA 0T LES 3 VRIERIS
EELTEAShD &, REREE3IERITLABY T,
RSB > TELLRY RN E LTS,
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Korean MIC statement

If this symbol appears on your product, the accompanying statement is applicable.
B= 77| (FtE& EESLII7])

@ ol 77| £ 718822 WALM S ES 2 7|71 2N

FHXAAM = 22 Z& XG0l ALEe 5= ASHCL
Mercury statement

This product contains mercury in the lamp (<5mg Hg). Disposal of mercury may be regulated due to
environmental considerations. For disposal or recycling information, contact your local authorities or the
Electronic Industries Alliance: www.eiae.org.

Other telecommunications notices

Notice to users of the Canadian telephone network

This product meets the applicable Industry Canada technical specifications.

The Ringer Equivalence Number (REN) is an indication of the maximum number of terminals allowed to be
connected to a telephone interface. The terminus of an interface may consist of any combination of devices,
subject only to the requirement that the sum of the RENSs of all the devices does not exceed five. The modem
REN is located on the rear of the equipment on the product labeling.

Telephone companies report that electrical surges, typically lightning transients, are very destructive to
customer terminal equipment connected to AC power sources. This has been identified as a major nationwide
problem. It is recommended that the customer install an appropriate AC surge arrestor in the AC outlet to which
this device is connected. An appropriate AC surge arrestor is defined as one that is suitably rated, and certified
by UL (Underwriter’s Laboratories), another NRTL (Nationally Recognized Testing Laboratory), or a recognized
safety certification body in the country/region of use. This is to avoid damage to the equipment caused by local
lightning strikes and other electrical surges.

This equipment uses CA11A telephone jacks.

Notice to users of the New Zealand telephone network

The following are special conditions for the Facsimile User Instructions.

The grant of a telepermit for any item of terminal equipment indicates only that Telecom has accepted that the
item complies with minimum conditions for connection to its network. It indicates no endorsement of the
product by Telecom, nor does it provide any sort of warranty. Above all, it provides no assurance that any item
will work correctly in all respects with another item of telepermitted equipment of a different make or model, nor
does it imply that any product is compatible with all of Telecom's network services.

This equipment shall not be set up to make automatic calls to the Telecom's 111 Emergency Service.

This equipment may not provide for the effective hand-over of a call to another device connected to the same
line.

This equipment should not be used under any circumstances that may constitute a nuisance to other Telecom
customers.

Some parameters required for compliance with Telecom's telepermit requirements are dependent on the
equipment (PC) associated with this device. The associated equipment shall be set to operate within the
following limits for compliance to Telecom's specifications:

¢ There shall be no more than 10 call attempts to the same number within any 30 minute period for any
single manual call initiation, and

e The equipment shall go on-hook for a period of not less than 30 seconds between the end of one attempt
and the beginning of the next call attempt.
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¢ The equipment shall be set to ensure that automatic calls to different numbers are spaced such that there
is not less than 5 seconds between the end of one call attempt and the beginning of another.

South Africa telecommunications notice

This modem must be used in conjunction with an approved surge protection device when connected to the
PSTN.

Using this product in Germany

This product requires a German billing tone filter (Lexmark part number 14B5123) to be installed on any line
which receives metering pulses in Germany. Metering pulses may or may not be present on analog lines in
Germany. The subscriber may request that metering pulses be placed on the line, or can have them removed
by calling the German network provider. Normally, metering pulses are not provided unless specifically
requested by the subscriber at the time of installation.

Using this product in Switzerland

This product requires a Swiss billing tone filter (Lexmark part number 80D1877) to be installed on any line
which receives metering pulses in Switzerland. The Lexmark filter must be used, as metering pulses are
present on all analog telephone lines in Switzerland.

German GS mark notice

Model: Lexmark X34x Series
Machine type: 7003-xxx

Mailing address

Lexmark Deutschland GmbH
Postfach 1560

63115 Dietzenbach

Physical address

Lexmark Deutschland GmbH
Max-Planck-StraBe 12
63128 Dietzenbach

Phone: 0180 - 564 56 44 (Product Information)
Phone: 01805 - 00 01 15 (Technical Support)

E-mail: internet@lexmark.de
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Noise emission levels

The following measurements were made in accordance with ISO 7779 and reported in conformance with ISO
9296.

1-meter average sound pressure, dBA

Printing 52
Scanning 48
Copying 52
Idling 30

Printer energy consumption

The following table documents the power consumption characteristics of the printer.

[ [oTe ] Description Power consumption
Printing Printer is generating hard copy output | 420 W
Ready Printer is waiting for a print job 70 W
Power Saver Printer is in energy saving mode 13 W
Off Printer is plugged into a wall outlet, but |0 W
switch is turned off

The power consumption levels listed in the previous table represent time—averaged measurements.
Instantaneous power draws may be substantially higher than the average.

Power Saver

This printer is designed with an energy—saving mode called Power Saver. The Power Saver Mode is equivalent
to the EPA Sleep Mode. The Power Saver Mode saves energy by lowering power consumption during extended
periods of inactivity. The Power Saver Mode is automatically engaged after this printer is not used for a
specified period of time, called the Power Saver Timeout. The factory default Power Saver Timeout is 30
minutes for the Lexmark X340.

By using the printer configuration menus, the Power Saver Timeout can be modified between 1 minute and 240
minutes. Setting the Power Saver Timeout to a low value reduces energy consumption, but may increase the
response time of the printer. Setting the Power Saver Timeout to a high value maintains a fast response, but
uses more energy.

Total energy usage

It is sometimes helpful to calculate the total printer energy usage. Since power consumption claims are
provided in power units of Watts, the power consumption should be multiplied by the time the printer spends in
each mode in order to calculate energy usage. The total printer energy usage is the sum of each mode's
energy usage.
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ENERGY STAR

V4 i
/4

ENERGY STAR

Waste from Electrical and Electronic Equipment (WEEE) directive

B

The WEEE logo signifies specific recycling programs and procedures for electronic products in countries of the
European Union. We encourage the recycling of our products. If you have further questions about recycling
options, visit the Lexmark Web site at www.lexmark.com for your local sales office phone number.

Laser advisory label

A laser notice label may be affixed to this MFP.
LUOKAN 1 LASERLAITE

VAROITUS! Laitteen kayttdminen muulla kuin tdssa kayttoohjeessa mainitulla tavalla saattaa altistaa kayttajan
turvallisuusluokan 1 ylittdvalle nakyméattémalle lasersateilylle.

KLASS 1 LASER APPARAT

VARNING! Om apparaten anvénds pa annat satt an i denna bruksanvisning specificerats, kan avnandaren
utsattas for osynlig laserstralning, som 6verskrider gransen for laserklass 1.

Laser notice

This MFP is certified in the U.S. to conform to the requirements of DHHS 21 CFR Subchapter J for Class | (1)
laser products, and elsewhere is certified as a Class | laser product conforming to the requirements of IEC
60825-1.

Class | laser products are not considered to be hazardous. The MFP contains internally a Class lllb (3b) laser
that is nominally a 5 milliwatt gallium arsenide laser operating in the wavelength region of 770-795 nanometers.
The laser system and MFP are designed so there is never any human access to laser radiation above a Class
I level during normal operation, user maintenance, or prescribed service condition.

Hot surface notice

AR ST I BT -
BEL ¢ B BRSNS BRI
P AT A T -
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A

ADF
loading original documents 36
paper capacity 36

broadcast fax 44
buttons, control panel 20

C

canceling
fax job 50
using Stop button 22
card stock 34
cartridge error 91
cartridge, toner
installing 62
ordering 70
recycling 70
redistributing toner 63
removing 61
characters, entering 50
Cleaning
outside of MFP 67
cleaning
inside of MFP 68
scanner glass 67
collating copies 40, 52
connecting the MFP
to a telephone 15
to a telephone wall jack 14
control panel
installing another language overlay 10
using 20
control panel buttons 20
control panel menus
Copy Defaults 23
Fax Advanced 23
Fax Defaults 24
navigating 22

Copy Defaults menu 23
copy troubleshooting 84
copying
collated copies 52
documents 51
enlarging an image 53
reducing an image 53

D

delay send 44
distinctive ring patterns 49
documents
faxing 43
loading into ADF 36
loading on scanner glass 37
printing 39
scanning 55

E

electronic emission statement 94
emission statement 94
enlarging an image 53
entering characters 50
envelopes

loading 33

printing 39
error messages

200 Paper Jam 92

201 Paper Jam 92

202 Paper Jam 92

241 Paper Jam 93

242 Paper Jam 93

251 Paper Jam 93

Change Cartridge 91

Change Media 91

close front door 91

Defective Toner Cartridge 91

Digital Line Detected 91

Fax failed 91

Insufficient Collation Area 92

Load Manual 91
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Load Media 91
Memory Full 92
No Answer 91
No Dial Tone 91
Photoconductor Near Life 92
Qlink Not Found 91
Replace Photoconductor 92
Short Paper 92
Toner Low 92
Unsupported Toner Cartridge 91
USB Not Connected 91

error messages troubleshooting 91

F

fax activity reports 47
Fax Advanced menu 23
Fax Call log 47
Fax Defaults menu 24
Fax Job log 47
fax troubleshooting 89
faxing
adding a pause 45
adding a prefix 45
at a scheduled time 44
canceling a fax job 50
delay send 44
forwarding 46
receiving a fax automatically 45
receiving a fax manually 46
sending automatically 43
sending manually 43
to a group (broadcast) 44
FCC statement 94
forwarding faxes 46
front cover 18
front output slot 18

|

installing
additional paper tray 11
control panel overlay 10
software 12, 13

J

jams and misfeeds troubleshooting 75
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K

keypad, using 50

L

labels 33
loading

M

card stock 33

documents into the ADF 36
documents on the scanner glass 37
envelopes 33

labels 33

manual feeder 32

paper 28, 32

paper tray 28

transparencies 33

menus, control panel

Copy Defaults 23
Fax Advanced 23
Fax Defaults 24

MFP 84
mode, changing 24

N

network setup 25
noise emission levels 100

)

output location

front output tray 38
rear paper exit 38
selecting 38

overlay, installing 10

P

paper

loading 28, 32

paper jam 76

paper saver 40, 52
paper size, setting 35
paper tray,installing 11
paper type, setting 35
pause 45

Phone Book

adding shortcuts 47
deleting shortcuts 48
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editing 48 scan troubleshooting 88
printing 48 scanner glass
searching 48 cleaning 67
photoconductor, replacing 65 loading documents 37
power supply port 19 scanning
prefix 45 configuring additional applications 56
Presto! PageManager 27 documents 55
print cartridge assembly 65 from an application 56
print properties options 59
opening 26 using the computer 55
tabs 26 sending a fax
using 26 at a scheduled time 44
print troubleshooting 84 automatically 43
printing manually 43
collated copies 40 to a group (broadcast) 44
documents 39 setting
envelopes 39 distinctive ring 49
last page first 41 paper size 35
menu report 22 paper type 35
multiple pages on a sheet 40 Speed Dial 47
transparencies 40 shortcuts
setting up 47
Q using 48
QLINK, using 27 software
installing 12, 13
R Presto! PageManager 27
print properties 26
rear cover 19 QLINK 27

rear output slot 38

rear paper exit 38

receiving a fax
automatically 45

reinstalling 74
removing 74
Speed Dial buttons 48

manually 46 station ID 49
recycling Lexmark products 70 T
redistributing toner 63
reducing an image 53 timeout option 24
removing toner
software 74 low 92
toner cartridge 61 redistributing 63
reports toner cartridge
fax activity 47 instal!ing 62
Fax Call log 47 ordering 70
Fax Job log 47 recycling 70
menu 22 redistributing toner 63
Phone Book 48 removing_61
transparencies
S printing 40
safety information 2 troubleshooting
copy 84
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error messages 91
fax 89

jams and misfeeds 75
print 84

scan 88

setup 72

U
USB port 19

W
Web site 8
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